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1. Introduction 
 
The ARIS ASCII Grid Reader for ArcGIS makes it possible to view files in the ESRI ASCII 
Grid format in ArcCatalog and ArcMap without having to convert those files. 
 
Spatial models, which have been written outside of standard GIS applications (i.e. written in 
C/C++ or Fortran), often use the ASCII Grid format for storing intermediate and / or final 
results. In order to view this data in ArcMap, it is necessary to use ArcToolbox to perform a 
conversion from ASCII Grid to a native ESRI GRID. This ESRI GRID can then be viewed in 
ArcMap. Another option would be to use ArcObjects to perform the conversion in the 
background, and show the result. 
 
ARIS now has a solution, which makes it possible to preview ASCII Grids directly and without 
conversion in ArcCatalog, and to add them to ArcMap. All the default raster operations in 
ArcMap (for example the Raster Calculator) can be applied to the ASCII Grid. 
Using ASCII Grid files directly also improves overall performance (compared to a background 
conversion). Initially there is a time gain of about 50% (several seconds for a raster of 
500.000 cells), if the same file is used again the gain is even bigger (over 95%). Also, no 
temporary files are created, whereas a conversion always produces a new file on the hard 
disk, which need to be cleaned up after some time. 
Floating-point and integer type ASCII Grids are recognized automatically, whereas 
ArcToolbox creates a floating-point grid by default, unless explicitly specified by the user. An 
important difference between floating-point and integer type rasters is that a Unique Value 
Classification is available for integer rasters. 
 
The ARIS ASCII Grid Reader is implemented as a dll which, once placed in the correct 
ArcGIS directory, is used to identify files in the ASCII Grid format. 
 
The ARIS ASCII Grid Reader can be used with any version of ArcGIS (ArcView, ArcEditor 
and ArcInfo, version 8.0 or higher). 
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2. Installation 

2.1 ArcGIS 8.x 
Installation of the ASCII Grid Reader is accomplished with the following two steps: 
 

1. The automatic setup (arisasciigrid.exe) needs to be executed by a user with 
administrative privileges. The setup procedure checks if ArcGIS is installed, and 
determines the installation directory. Any necessary changes in configuration files for 
ArcGIS are carried out automatically. 

2. Using ArcGIS 8.x, other users who want to use the ASCII Grid Reader will need to 
finish the setup procedure by clicking on the Start button and choosing Programs | 
ARIS ASCII Grid Reader for ArcGIS | Install for current user.  

2.2 ArcGIS 9.2 
The automatic setup (arisasciigrid.exe) needs to be executed by a user with administrative 
privileges. The setup procedure checks if ArcGIS is installed, and determines the installation 
directory. Any necessary changes in configuration files for ArcGIS are carried out 
automatically. 

2.3 ArcGIS 9.3 and ArcGIS 9.3.1 
In ArcGIS 9.3 and 9.3.1 disable the default *.asc: 
• Open in ArcMap or ArcCatalog the menu "Tools" / "Options" 
• Select the tab "Raster".  
• On this tab click button "File Formats".  
• Uncheck the "Arc/Info ASCII GRID *.asc" format. 
• Currently this will have no effect: This is a bug being fixed by ESRI in ArcGIS 10 
 

 
 
To disable the default *.asc format, until the ESRI bug fix, do the following: 
• In the <program files>\ArcGIS\bin directory: make a backup copy of RasterFormats.dat  
• Edit RasterFormats.dat (with Notepad or any other text editor). 
• Remove the reference to "*.asc" this is the row that looks like: 
 

<e on="y" nm="Arc/Info ASCII GRID" ex="*.asc" et="ASC" at="0x2f" /> 
 

• Save RasterFormats.dat and start ArcMap or ArcCatalog. 
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2.4 De-installation 
De-installation of the ASCII Grid Reader is straightforward, but make sure you exit all ArcGIS 
applications before de-installing the ASCII Grid Reader. 
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3. Registration 
The distributed version of the ASCII Grid Reader is a fully functional version, except that there 
is a reminder message shown, each time you open an ASCII Grid file. 

 
Pressing the Buy Now! button will take you to our online store, where you can order this 
product. Note that you will need the hardware fingerprint of the computer where you want to 
install the tool, shown in the dialog below (appears when you press Enter Key). After you 
complete your purchase, a personal registration key will be sent to you by email. Please store 
this key in a safe place.  
Pressing the Enter Key button will present you with the following dialog, where you must enter 
your name and the registration key. 
 

 
Once you have entered a valid registration key, press OK. This key will be stored on your pc. 
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4. Using ASCII Grid files 
After the setup procedure has finished, ASCII Grid files can be used in ArcMap and 
ArcCatalog with the standard functions: In ArcMap, use the Add Data button to add an ASCII 
Grid to the map: 
  

 

Note: Only ASCII Grid files that have a file extension *.asc, *.grd,  *.agr or *.aig can be used. 
Other file extensions will be ignored. 

 
Likewise, all standard function, such as the Raster Calculator and other Spatial Analyst 
functions are available.  
 
ArcCatalog recognizes ASCII Grids automatically. 
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Figure 1. Preview of an ASCII Grid shown in ArcCatalog. 

With the ARIS ASCII Grid Reader an ASCII Grid is automatically stretched between the low 
and high values within the grid. 
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5. Projections 
Projection information is passed to ArcMap and ArcCatalog, if a projection file accompanies 
the ASCII grid. Projection files should have the same name as the ASCII file, but with a .prj 
extension. For instance, if the ASCII grid is named myraster.asc, the projection file should be 
called myraster.prj. Both files should be placed in the same folder. 
 
Even if all your data uses the same projection, you can still add a projection file to the 
asciigrid, since this will stop ArcMap from warning you that your raster doesn’t contain 
projection information. 
 
The easiest way to find a valid projection file is to browse the ArcGIS installation folder, in the 
subfolder Coordinate Systems. For instance, the projection file for WGS 1984 can be found in 
C:\Program Files\ArcGIS\Coordinate Systems\Geographic Coordinate Systems\World. Just 
copy this file to the folder containing your ASCII grid and rename the copy to match the base 
name of the grid. 
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6. FAQ 
Q: Only “Administrator” can see ASCII Grids. 
A: Log in to your ordinary user account. Then, from the Start Menu, choose Programs > 

ARIS ASCII Grid Reader > Install for current user. 
 
Q: I installed the ASCII Grid Reader, but ArcMap and ArcCatalog still don’t see ASCII 

Grids. 
A: There can be several reasons for ArcGIS not to recognize ASCII Grids, some of 

which are: 
- You have Windows NT 4.0: There is an issue with that version of Windows that 

we haven’t been able to work around yet. In most cases it should work, though. 
Please contact us at helpdesk@aris.nl for more information. 

- Something went wrong during the installation. You can try to run ArcMap or 
ArcCatalog as administrator once, open at least one raster file, then try again 
from your ordinary user account. If it still doesn’t work, contact us at 
helpdesk@aris.nl. 

- If you have ArcGIS version 9.x, you can try to manually install the ASCII Grid 
Reader, locate asc.dll on your filesystem, and then use the menu Tools > Options 
> Raster > File Formats to add it to ArcMap or ArcCatalog. 

 
Q: Some ASCII Grids work, others don’t, why is that? 
A: The ASCII Grid Reader currently only recognizes files that have a file extension *.asc, 

*.grd, *.agr or *.aig. If your files are called, say, myraster.ras, or any other file 
extension, you have no option other than renaming it. If that’s not feasible for you, 
send us an email and we’ll consider adding your file extension in the next version. 

A: Possibly your ASCII Grid is not in the correct format, see chapter 8 to check if your 
file complies with the ESRI ASCII Grid Format.  

 
Q: All my ASCII Grids show up twice in ArcCatalog, why? 
A: One of those two has this icon: , the other has this one: , right? This is caused 

by ArcGIS recognizing .asc files as text tables by default. It doesn’t harm, but if you 
want, you can turn off the text tables. Start ArcCatalog, open the Tools > Options 
menu and choose the General tab. Under Which types of data do you want the 
Catalog to show make sure Text Files is unchecked. 

 
Q: Does the ASCII Grid Reader work with ArcGIS 9.2, 9.3 and 9.3.1? 
A: Yes, ASCII Grid Reader version 2.x works with ArcGIS 9.2, 9.3 and 9.3.1 (in ArcGIS 

9.3 and 9.3.1 a bug is present, see question below). 
 
Q: I have removed ASCII Grid Reader. However when I start ArcGIS I still see pop-up 

messages telling me I have to register. 
A: Before de-installing ASCII Grid Reader make sure you have no ArcGIS applications 

running. If, by accident, you did remove ASCII grid reader when ArcMap or 
ArcCatalog was still running your best bet is to re-install ASCII grid reader and then 
remove it again after you exited all ArcGIS applications. 

 
Q: Does the ASCII Grid Reader work with ArcIMS? 
A: It should work with ArcIMS version 4.0.1 or higher. If you have version 4.0.1, you 

need to install the correct patch, see 
http://support.esri.com/index.cfm?fa=knowledgebase.techarticles.articleShow&d=264
13 for details. 

 
Q: In ArcGIS 9.2 and higher, default support has been added for ASCII grid. Do I still 

need the ARIS ASCII Grid Reader? 
A: The default ASCII Grid support in ArcGIS 9.2 and higher shows the grid stretched 

between a theoretically minimum and maximum. This usually results in a grey or 
black image. The ARIS ASCII Grid Reader shows your grid stretched between the 

http://support.esri.com/index.cfm?fa=knowledgebase.techarticles.articleShow&d=26413
http://support.esri.com/index.cfm?fa=knowledgebase.techarticles.articleShow&d=26413
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minimum and maximum values in the ASCII Grid file and thus gives a realistic view of 
you grid. 

A: In ArcGIS 9.2 default only *.asc is supported by ESRI. The ARIS ASCII Grid Reader 
supports *.asc, *.agr, *.aig and *.grd.  

 
Q: In ArcGIS 9.3 and 9.3.1 *.asc does not show a realistic view of the grid? 
A: Due to a bug in ArcGIS 9.3 and 9.3.1 disabling the Arc/Info ASCII GRID (*.asc) does 

not have any effect. ArcGIS still uses the ESRI reader for *.asc. See chapter 2 for 
instructions to remove the default *.asc reader. 
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7. History 
This is the version history for the ARIS ASCII grid reader. The version number can be found 
by locating the file asc.dll, in a default ArcGIS installation this file should be in the folder 
C:\Program Files\Common Files\ESRI\Raster\usr\lib\NTx86\RasterFormats. Right click on this 
file and choose Properties. The Version tab contains version information.  
 
Version Features 
1.0 First release 
1.1 Added support for .grd and .agr file name extensions 
1.2 Added support for projections in a .prj file 
1.2.1 ArcGIS does not crash anymore when removing ASCII grids 
1.2.2 ArcGIS 9.1 does not disappear anymore when starting up with ASCII Grid Reader 
 Solved the popup message flood occurring sometimes when starting an 

unregistered version of ASCII Grid Reader 
ArcGIS does not crash anymore when previewing a .prj file 

 Check on locked files when removing/updating ASCII grid reader installation 
2.0.1 Installation procedure support for installing with ArcGIS 9.2 
 Added support for .aig file name extension 
2.0.2 Documentation update for ArcGIS 9.3 and 9.3.1 
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8. The ESRI ASCII Grid Format 
 
This description is taken from the ArcGIS Desktop documentation. 
The ASCII file must consist of header information containing a set of keywords, followed by 
cell values in row-major order. The file format is: 

 
<NCOLS xxx> 
<NROWS xxx> 
<XLLCENTER xxx | XLLCORNER xxx> 
<YLLCENTER xxx | YLLCORNER xxx> 
<CELLSIZE xxx> 
{NODATA_VALUE xxx} 
row 1 
row 2 
. 
. 
. 
row n 

      
where xxx is a number, and the keyword nodata_value is optional and defaults to -9999. Row 
1 of the data is at the top of the raster, row 2 is just under row 1, and so on. For example: 

 
ncols 480 
nrows 450 
xllcorner 378923 
YLLCORNER 4072345 
cellsize 30 
nodata_value -32768 
43 2 45 7 3 56 2 5 23 65 34 6 32 54 57 34 2 2 54 6  
35 45 65 34 2 6 78 4 2 6 89 3 2 7 45 23 5 8 4 1 62  ... 

      

The nodata_value is the value in the ASCII file to be assigned to those cells whose true value 
is unknown. In the raster they will be assigned the keyword NODATA.  

Cell values should be delimited by spaces. No carriage returns are necessary at the end of 
each row in the raster. The number of columns in the header is used to determine when a 
new row begins.  

The number of cell values must be equal to the number of rows times the number of columns, 
or an error will be returned. 
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Appendix A. License Agreement 
 
ARIS Software License Agreement for ARIS ASCII Grid Reader for ArcGIS 
-------------------------------------------------------------------------- 
This is a license agreement and not an agreement for sale. This license agreement 
(hereinafter referred to as AGREEMENT) is between the end user (hereinafter referred 
to as LICENSEE) and ARIS b.v., The Netherlands (hereinafter referred to as ARIS), and 
gives the LICENSEE certain limited rights to use the proprietary ARIS software ASCII 
Grid Reader for ArcGIS, examples, on-line and hardcopy documentation and updates (if 
applicable), hereinafter referred to as PRODUCT. All rights not specifically granted 
in this AGREEMENT are reserved to ARIS. 
 
Ownership and grant of license 
------------------------------------------------- 
ARIS and its third party licensor(s) retain exclusive rights, title, and ownership of 
the copy of the PRODUCT licensed under this AGREEMENT and hereby grant to LICENSEE a 
personal, non-exclusive, non-transferable license to use the PRODUCT based on the 
terms and conditions of this AGREEMENT. From the date of receipt, the LICENSEE shall 
agree to make reasonable efforts to protect the PRODUCT from unauthorized use, 
reproduction, distribution, or publication. 
 
Copyright 
--------------- 
The PRODUCT is owned by ARIS and partly by its third party licensor(s) and is 
protected by Dutch copyright laws and subject to international laws, treaties, and/or 
conventions. 
The LICENSEE agrees not to export the PRODUCT into a country that does not have 
copyright laws that will protect ARIS's proprietary rights. 
 
Permitted uses 
----------------------- 
The LICENSEE may use the number of copies of the PRODUCT for which license fees have 
been paid on computer system(s) and/or specific computer network(s) for the LICENSEE's 
own internal use. 
 
The LICENSEE may install the number of copies of the PRODUCT for which license or 
update fees have been paid onto permanent storage device(s) on computer system(s) 
and/or specific computer network(s). 
 
The LICENSEE may make one (1) copy of the PRODUCT for archival purposes only, during 
the term of this AGREEMENT, unless the right to make additional copies has been 
granted by ARIS to the LICENSEE in writing. 
 
The LICENSEE may use parts of the documentation in other documents for LICENSEE's own 
internal use only with the purpose of using or encouraging to use the PRODUCT. 
 
Uses not permitted 
------------------------------ 
The LICENSEE shall not sell, rent, lease, assign, timeshare, or transfer, in whole or 
in part, or provide unlicensed third parties access to prior or present versions of 
the PRODUCT, any updates, or the LICENSEE's rights under this AGREEMENT. 
 
The LICENSEE shall not reverse, engineer, decompile, or disassemble the PRODUCT, or 
make any attempt to alter the license number and other license information shown in 
the about box. 
 
The LICENSEE shall not remove or obscure any ARIS copyright or trademark notices. 
 
The LICENSEE shall not make additional copies of the PRODUCT beyond what is laid down 
in the "permitted uses" section of this AGREEMENT. 
 
Term 
-------- 
The license granted by this AGREEMENT shall commence upon LICENSEE's receipt of the 
PRODUCT and shall continue until such time as:· the LICENSEE elects to discontinue the 
use of the PRODUCT; 
· ARIS terminates the agreement due to the LICENSEE's material breach of this 
  AGREEMENT. 
Upon termination of this AGREEMENT in either instance, LICENSEE shall return to ARIS 
the PRODUCT and any whole or partial copies in any form. The parties hereby agree that 
all provisions operating to protect the rights of ARIS shall remain in force, should 
breach occur. 
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Limited Warranty 
-------------------------- 
ARIS warrants that the media upon which the PRODUCT is provided will be free from 
defects in materials and workmanship under normal use and service for a period of 
ninety (90) days from the date of receipt. 
 
Except for the above express limited warranties, the PRODUCT is provided "as is", 
without warranty of any kind, either express or implied, including, but not limited 
to, the implied warranty of merchantability and fitness for a particular purpose. 
 
Exclusive Remedy and Limitation of Liability 
-------------------------------------------------------------------- 
During the warranty period, ARIS's entire liability and the LICENSEE's exclusive 
remedy shall be the return of the license fee paid for the PRODUCT that does not meet 
ARIS's limited warranty and that is returned to ARIS or its dealers with a copy of the 
LICENSEE's proof of payment. 
 
ARIS shall not be liable for indirect, special, incidental, or consequential damages 
related to LICENSEE's use of the PRODUCT, even if ARIS is advised of the possibility 
of such damage. 
 
Waivers 
------------- 
No failure or delay by ARIS in enforcing any right or remedy under this AGREEMENT 
shall be construed as a waiver of any future or other exercise of such right or remedy 
by ARIS. 
 
Order of Precedence 
--------------------------------- 
 
Any conflict and/or inconsistency between the terms of this AGREEMENT and any purchase 
order, or other terms shall be resolved in favour of the terms expressed in this 
AGREEMENT, subject to Dutch law, unless agreed otherwise. 
 
Governing Law 
------------------------ 
This AGREEMENT is governed by the laws of the Netherlands without references to 
conflict of laws principles. 
 
Entire Agreement 
--------------------------- 
The parties agree that this constitutes the sole and entire agreement of the parties 
as to the matter set forth herein and supersedes any previous agreements, 
understandings, and arrangements between the parties relating hereto and is effective, 
valid, and binding upon the parties. 
 
ARIS is a registered trademark, the Netherlands. 
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